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Microsoft® Office Specialist 2016 Series 
 
 

Microsoft®
 

PowerPoint 2016 
Certification Guide 

Lesson 1: Getting Started 
Lesson Objectives 
In this lesson, you will learn what PowerPoint is and you will create simple presentations. You will also use 
some of the file management tools. Upon completion of this lesson, you should be able to: 

 start PowerPoint 

 create a new blank presentation or 
create one from a theme or template 

 identify elements on the screen 

 use the Ribbon 

 view Screen Tips 

 use the Quick Access Toolbar 

 move around in a presentation 

 change slide size options 

 arrange windows, view a presentation in a new window, 
or switch between presentations 

 manage presentation files 

 use Backstage to save, open, and close a presentation 

 save a presentation to OneDrive 

 save in a different file format 

 maintain backward compatibility 

 add and modify document properties 

 use presentation views 

What is PowerPoint? 
PowerPoint is a powerful presentation software used to produce professional, interactive slide shows. 
PowerPoint is often used to enhance the delivery of information to an audience. It can also be used to present 
information on kiosks, over the Internet, and as videos that can be uploaded to popular sites such as YouTube. 
Advanced PowerPoint users even use PowerPoint to develop interactive games and e-learning. 

PowerPoint presentation examples abound on the Internet. A quick Internet search for “examples of 
PowerPoint presentations” returns over two million results. On YouTube alone, any YouTube video that looks 
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like it is moving from slide to slide could have been developed in PowerPoint. Another place you can go to 
view examples of PowerPoint Presentations is the PPT Search Engine website at pptsearchengine.net. 

Starting PowerPoint 
To start the PowerPoint application in Windows 10, use one of the following methods: 

• press the WINDOWS key on the keyboard to open the Start page, click or tap 
the PowerPoint 2016 tile;  

 
• click Start, scroll through the list of apps, and then click or tap  

PowerPoint 2016; or 
 

• in the taskbar, click the PowerPoint 2016 Quick Launch icon 
 

When you start PowerPoint, the program displays a startup screen (shown in the following figure) of available 
templates and themes to help you get started quickly. A template is a boiler plate that already contains 
elements, such as various sample slides complete with placeholders and formatting. You also have an option 
to create a blank presentation. If you have been using PowerPoint for a little while, then your recently used 
files display on the left side of the window. 

 
You can click a template on the startup screen to create a new file, click a file in the Recent list to open it, or 
click the Open Other Documents link to go to the Backstage view. You use Backstage view to create, open, 
save, print and manage your files.  

Creating New Presentations 
Objective 1.1.1, 1.1.2 

All PowerPoint presentations are based on a template. PowerPoint includes templates for a wide variety of 
presentations. Some templates display on the startup screen, but you can access many more on the New tab 
of the Backstage view (as shown in the following figure).  
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Search – Enter a search term to find online templates and themes from Office.com. 

Suggested Searches – Click any of these predefined searches to display related themes and templates. 

Themes and Templates – Suggested or recently used themes and templates appear in the gallery. A 
thumbnail of the first slide is displayed to help you select the theme or template you want. 

Blank Presentation – Choose the first option in the themes and templates area to create a blank 
presentation, which contains only the title slide with no colors or design elements, ready for you to enter 
text. When you start with a blank presentation, you can create your own content and apply your own choice 
of colors, backgrounds, images, and other design elements. 

When you select a template or theme (other than the Blank Presentation template), you have the option of 
choosing a variation before clicking the Create button. There are no restrictions on how many presentations 
you can create and work with at one time; the amount of available system memory will determine this limit. 

To create a new blank presentation, use one of the following methods: 

• start PowerPoint and click Blank Presentation; or 

• from within a presentation, click File, click New, and click Blank Presentation; or 

• press CTRL+N. 

To use a template, click File, click New, click a template, choose a variation, and then click Create. 

Learn to start PowerPoint 
In this exercise, you will learn to start PowerPoint and create a blank presentation. 

1 Click the Start button, scroll the Start menu, then click or tap PowerPoint 2016 to start PowerPoint. The 
startup screen displays. 

2 In the startup screen, click the Blank Presentation template to create a new, blank presentation. 

3 Keep the presentation open for the next exercise. 

Search 

Suggested 
Searches 
 
 
 
 
Templates 
and Themes 
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Looking at the PowerPoint Window 
The PowerPoint window contains the familiar Ribbon interface of the other Microsoft Office programs. If you 
are familiar with another version of PowerPoint, you will find everything where it was, plus some additional 
features. 

 
File Tab – Click the File tab to open the Backstage view. When you open the Backstage view, PowerPoint 
hides the presentation and displays file management options, such as new, save and print options, in a full-
screen window. 

Quick Access Toolbar – Provides quick access to frequently used commands. Located above the Ribbon 
(default location) or below the Ribbon, the Quick Access Toolbar is customizable. 

Ribbon Tab – The Ribbon includes various tabs, and each contains commands grouped for specific purposes, 
such as editing, inserting graphics, adjusting the view, or modifying the page layout.  

Title Bar – Displays the name of the open presentation followed by “PowerPoint” (for example, Staff Retreat 
2016 - PowerPoint). The title bar is located at the top of the screen. If more than one window is open on the 
screen, the Title Bar of the active window displays in a different color or intensity of color. 

Tell Me – Similar to a Search bar.  Enter words or phrases to get help or find features or tools to quickly 
complete a task. 

Min/Restore/Max/Close – Affect the size of the application window on the screen. 

Share – Opens the Share pane, which allows you to invite others to view or edit your presentation. 

Ribbon – The primary command interface in all Office programs; the Ribbon provides quick access to 
commands that are organized into groups per the type of function, such as Insert, Design, and Review. 

 
Ribbon 
 

Slide Pane 

Ribbon Group 

Slide 
Thumbnail 

Split Bar 

Status Bar View Buttons 
Zoom Slider 

File Tab 

Quick Access Toolbar 
Ribbon Tab 

Title Bar 
Tell Me Min/Restore/Max/Close 

Slide Navigation Pane 
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Ribbon Groups – Options on the Ribbon are arranged into groups of related commands. Some groups 
include a dialog box launcher button  at the bottom right. Clicking the dialog box launcher opens a dialog 
box or task pane which provides access to additional options and settings. 

Slide Navigation Pane – Displays a thumbnail (miniature) view of each slide, used to organize and navigate 
slides in your presentation. If you are using Outline view, this pane becomes the Outline View pane. 

Slide Pane – The work area used to view and edit the selected slide. 

Split Bar – Drag this left or right to increase or decrease the size of the Slide Navigation (or Outline View) 
pane. 

Status Bar – Displays presentation information, such as current slide and total number of slides. The status 
bar also displays the Notes button and Comments button (which open additional panes), and it also includes 
the View buttons, and the Zoom slider at the far right. 

View Buttons – Alternate quickly between different views of a presentation. Use Normal to view and edit 
slides; Slide Sorter to view and organize all the slides in a presentation; Reading to view the presentation as 
if it were a show; and Slide Show to view the current slide as it would be displayed to an audience (press ESC 
to exit this view). 

Zoom Slider – Click the – and + buttons at either side of the slider to decrease or increase the zoom 
percentage in increments of 10%, or drag the slider to choose a zoom percentage. PowerPoint displays the 
current zoom percentage in the Zoom level button, which is at the right of the View buttons. You can also 
click this button to set a custom or specific zoom percentage. Click the button to the far right of the zoom 
buttons to fit the active slide within the PowerPoint window. 

Other Features 
The previous figure displays commonly used areas of the PowerPoint application window. However, because 
you can customize PowerPoint’s appearance, not all the parts shown here always appear. For instance, you 
can choose to turn the ruler on if you want to set a tab to align specific information on the slide, and then 
turn it off again to maximize the workspace on your screen. You can also set up or turn off defaults, such as 
the Mini toolbar or Live Preview, for each new presentation. 

Scroll bars appear automatically when the application window is too small to display all its contents. As you 
add slides to your presentation, you may not be able to see all of them at once in the slide navigation pane, 
and a vertical scroll bar will display at the right side of the application window. Click in the vertical scroll bar 
or drag the scroll box to move up and down within the presentation. A horizontal scroll bar will appear only 
if the presentation is wider than the screen can display; you can use it when you want to move sideways 
within the active slide. 

Previous Slide  and Next Slide  buttons appear at the bottom of the vertical scroll bar. Click them to move 
from one slide forward to the next, or back to the previous slide. 

Moving Around in Presentations 
When you are working with a presentation, small pictures of each slide appear in the Slide Navigation pane 
on the left of the screen. You can move through the presentation or select a specific slide using one of the 
following methods: 

• click a slide in the Slide Navigation pane; or 

• use the scroll bar on the right of the pane; or 
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• press PAGE DOWN or DOWN arrow to move forward one slide; or 

• press PAGE UP or UP arrow to move backward one slide; or 

• press HOME to move to the first slide; or 

• press END to move to the last slide. 

Learn to create presentations using themes and 
templates 

In this exercise, you will create one presentation using a theme, and then another one from the Office.com 
templates. 

1 In the PowerPoint window, you should be viewing a blank presentation. 

2 Click File and then click New. 

3 Click in the Search box, type: Slice and press ENTER. 

4 In the Templates and Themes area, click the Slice thumbnail to open the Slice theme dialog box. 

 Notice the variations on the right, and navigation arrow buttons to the left and right of the dialog box. 
These arrows allow you to move through the available template and theme options. 

5 Click the navigation arrow under the Title Layout image to view the available theme layouts. 

6 Click on each of the thumbnails on the right to view the presentation variations. 

7 Select the first variation in the second row and then click Create to create a blank presentation based 
on a color variant of the Slice theme. 

8 Click File and then click New. 

9 Click Business in the Suggested searches area. 

10 If necessary, scroll to locate the Business strategy presentation, click to select it, and then click Create; 
or simply double-click the presentation name to create a new presentation based on the template. 

Take a few moments to scroll through the presentation to view the various slides provided as a guide on how 
to use this template. 

11 Press the DOWN arrow or PAGE DOWN key to navigate to the next slides in the presentation, and then 
press HOME to return to the first slide. 

12 Click the Next Slide button at the bottom of the vertical scroll bar at the right of the screen. 

  PowerPoint now displays the next slide on the screen for you in the Slide Pane area. It also displays a 
highlighted box around this slide in the Slide Navigation pane. 

13 Click the Previous Slide button to see how PowerPoint now moves back to the previous slide. 

14 In the Slide Navigation pane, scroll down to the last slide and click it. 

15 Click anywhere in the vertical scroll bar in the Slide pane to see how PowerPoint moves to either the next 
slide or the previous slide (depending on where you clicked). 

16 Keep the presentations open for the next exercise. 
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Opening a Presentation 
You can open a presentation from any location. You can open as many presentations as needed; the only 
limitation is the amount of memory available on your system. 

Use one of the following methods to open a presentation: 

• click File, click Open, click an option from the list of locations, and then select the file you want; or 

• press CTRL+O; or 

• press CTRL+F12. 

 
PowerPoint displays the recent presentations in the same order as you opened them, with the most recent 
at the top of the list. When you reach the maximum number of files that display in this list, the oldest drops 
from the list. You can click the  (Pin this item to the list) button to the right of the file name to ensure 
that this file remains in the list until it is unpinned. By default, you can see up to 20 recent presentations at a 
time, but you can customize this number to suit your needs. 

Once the Open dialog box displays, you can navigate using the mouse or keyboard to display files or folders 
and then use one of the following methods to open a presentation: 

• double-click the file name; or 

• select the file, and then click Open or press ENTER; or 

• if the file is stored in a different location, navigate to the location and then use one of the above methods 
to open the file. 

Closing a Presentation 
Once you have finished editing or revising a presentation, you should close it to clear the screen and memory. 
This way, you can start or open another presentation without leaving old files on your screen. Although you 
can have multiple presentations open at one time, closing those you do not currently need saves on memory 
and processing time. 
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PowerPoint displays each document in its own window and you can use one of the following methods to 
close a presentation and the PowerPoint application: 

• click the  (Close) button for the PowerPoint application (at top right corner of the application 
window); or 

• click the File tab and then click Close; or 

• press CTRL+W or CTRL+F4; or 

• point at the PowerPoint button in the taskbar and then, in the window with the presentation, click the 
 (Close) button for that file. 

If you add or change something in a new or 
existing presentation that has not been saved yet, 
and then try to close the presentation, PowerPoint 
prompts with the option of saving the document. 
Choosing Cancel in the prompt window cancels the 
close process and returns you to the presentation.  

When you close all presentations in PowerPoint, the application remains open. Without any presentations 
open (not even a new blank one), the screen looks similar to the following: 

 
Notice that all options on the current ribbon tab appear dimmed (grayed out); this is a reminder that there 
are no presentations active and you must either create a new presentation or open an existing one before 
the features become available. 

Learn to open and close presentations 
In this exercise, you will open and close presentations. 

1 In the Ribbon, click File, and then click Open and review the files that currently display in the Recent list. 

Note: Your screen may show files in the list created by other users on the computer. 

2 In the middle pane, click Browse to open the Open dialog box. 

3 Using the directory tree in the Open dialog box, navigate to the 3266-Student-Files folder, then double-
click the Welcome to PowerPoint presentation to open it. 
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4 Click File, click Open, and then click Browse. The Open dialog box displays, and should already be 
showing the contents of the 3266-Student-Files folder.  

5 Click the Transitions presentation to select it, then click the Open button to open the presentation. 

6 Press CTRL+O and then click Browse to access the Open dialog box, then open the TEC Annual Review 
presentation. 

7 Press CTRL+W to close the TEC Annual Review presentation. The Transitions presentation should now 
be visible on the screen. 

8 Click the  (Close) button at the upper-right corner of the Transitions presentation window to close 
the presentation. The Welcome to PowerPoint presentation should now be visible on the screen. 

9 Click File, then click Close to close the Welcome to PowerPoint presentation. The two presentations you 
created previously should still be open. 

10 Click File, then click Open and review the files that display in the Recent list.  

The three files you opened display at the top of the list. 

11 In the Recent list, click Transitions to open the presentation again. 

12 Press CTRL+W to close the Transitions presentation. 

13 Keep the other two presentations open for the next exercise. 

Using the Ribbon 
The Ribbon is the first place you look to find the commands you require. Commands are grouped on tabs 
with each tab relating to a type of activity, such as adding images to a slide, changing a slide’s design, or 
adding animation and slide transitions. You can customize the Ribbon to display those commands you use 
most often), or to add or remove commands from a ribbon tab (not covered in this course). 

To reduce screen clutter, contextual ribbons (such as Drawing Tools, Picture Tools, and Table Tools) appear 
only when they are needed to complete a task or when a particular type of object is selected, such as a picture 
or a table. The following image displays the Table Tools ribbon, which contains two additional tabs (Design 
and Layout); this ribbon appears only if a table exists on the slide. 

 
A button that appears in a different color or that displays an outline is active. Many buttons are 
toggle buttons; that is, they deactivate when you click the same button again or click another 
choice. For instance, you can apply boldface to selected text by clicking the Bold button. While the command 
is active, the Bold button has a different color and outline. To turn off the boldface, click the button again. 

Each tab on the Ribbon is organized into groups of related commands. For example, the Home tab includes 
a group called Font, which contains buttons for formatting text characters; the Insert tab includes a group 
with different types of graphics or illustrations that can be inserted into a document. 
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If a group shows a feature with a scroll bar, it also has a  (More) button below the bottom scroll button. 
You can click the More button to display the full gallery (list) of options for that feature. 

 

The group generally displays options for the 
feature that can be selected directly without 
displaying the full gallery. 

 

When the More button is clicked, the gallery list 
appears. Notice that PowerPoint displays the current 
item in use, and then lists other available items for 
selection. PowerPoint will usually provide you with an 
option to browse for an item that is not in the current 
gallery, or to save a new customized item. 

Point at a gallery option and PowerPoint displays a Live 
Preview of how the selected item will appear if you 
apply the option. 

To turn off this feature, click the File tab, click Options 
to open the PowerPoint Options dialog box, click the 
General tab, and deselect the Enable Live Preview 
checkbox in the User Interface options section. 

You can click the dialog box launcher button 
 at the lower right of a group to display a 

dialog box, window, or task pane offering 
more options for this group of features. 

Within a dialog box, you can adjust, select, or 
change options for the selected feature, and 
click the OK button to apply your changes and 
close the dialog box. The Paragraph dialog 
box is shown here. 

 

A task pane is a multipurpose pane that appears docked on the right 
side of the PowerPoint window. Unlike dialog boxes, task panes do 
not cover up the active slide area. PowerPoint includes several task 
panes for working with slide content, objects, and other elements. The 
Format Shape task pane is shown at the left. 
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